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2.   Introduction and Excerpts from the RP1210B Document 

2.1. RP1210B Background 
TMC RP1210 has undergone two prior revisions, the original RP1210 Version 0 (commonly called RP1210-0), and 
RP1210A. The latest revision to take effect over the next several years called RP1210B presents mostly 
enhancements and additions to RP1210A as requested by OEM’s, software development firms specializing in 
onboard vehicle communications, as well as manufacturers of VDA’s.  Many loopholes were fixed in RP1210B. 

2.2. RP1210B, Backwards Compatibility, Operating Systems 
For the most part, RP1210B remains backward compatible with RP1210A.  The only real exception is that the J1850 
support (that not many people were using) got completely defined in RP1210B.  Something to note is that most VDA 
vendors and application providers are slowly getting rid of support for Windows 95/98/NT, and Millennium Edition 
(Me).  You should also note that with the addition of Windows Vista, there are many places for problems than we have 
had in the past.  We’ll cover this in more detail later. 

2.3. The Term “RP1210B-compliant”  
In previous versions of RP1210, no mention was given to the phrase “RP1210-compliant”.  This ultimately led to some 
confusion in the marketplace as to what that phrase actually meant.  The following sections define what it means to be 
an RP1210B-compliant VDA and what it means to be an RP1210B-compliant software application. 

 
In general, any RP1210B-compliant application should work with any RP1210B-compliant 
VDA for their commonly supported operating systems and protocols.     
 
RP1210B-compliant does not mean that a software application or VDA vendor “must”, 
“will”, or “even should”, support all operating systems and protocols or even any produced 
adapter. 
 

2.3.1. An RP1210B-Compliant VDA 

An RP1210B-compliant VDA: 
 Specifically follows the RP1210B document for that vendor’s supported operating systems and protocols.   

2.3.2. An RP1210B-Compliant Application 

An RP1210B-compliant software application: 
 Is any software application that implements and specifically follows the RP1210B document for that 

vendor’s supported operating systems and protocols. 
 Will present to the user a “complete” list of adapters installed in the C:\WINDOWS\RP121032.INI file.   

o In the past, applications failed to read past the first several entries, or failed to read the INI file 
correctly if it had multiple commas or spaces in it.  More later. 

 In addition to presenting the user with a “complete” list of adapters installed, any RP1210B-compliant 
application “shall allow” a user to use any of those adapters.   

o Some applications only have a select few adapters that they “allow”, thereby reducing VDA 
marketplace competition.  More on this later. 
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2.4. RP1210B-Compliant Application and “Supported VDA’s” 
The three major VDA vendors that authored this document pride themselves in following the RP1210 specifications to 
the letter.  Most of the problems arise with the main RP121032.INI file (discussed in detail later) or with configuring an 
application to use the adapter.  Other applications only “support” or “allow” the user to select only a few adapters (this 
is why your adapter may not be seen in the adapter configuration boxes).  Other applications limit what a generic 
RP1210-compliant adapter can do (such as not allowing reprogramming).  When it comes down to technical support 
dollars, it is easy to understand that application developers want to control which adapters they “support”.  No 
application provider wants to “have” their technical support representatives supporting “all” adapters on “all” PCs and 
on “all” operating systems. 

 
Does RP1210B-compliancy mean that an application “has to support” (meaning doing extensive testing and validation 
of) all of the adapters?  In short, the answer is “no”, they only have to allow the selection and use of all the adapters.  
The application developer can get around having to spend an enormous amount of testing and support by clearly 
stating that they will only “support” a specific list of adapters on a “specific type of PC” and on a “specific operating 
system”.  In order to keep from falling into a major time-eater situation, if an “outside-the-supported-list” adapter does 
not work, then they tell the user to aquire one of the supported adapters. 
 

2.5. Post Fall-2007-TMC-Nashville Notes on RP1210B-Compliancy 
S.12 created a task force at the Fall-2007 meeting in Nashville tasked with developing an RP1210 "compliancy 
worksheet" for both VDA's and applications.  This RP will be short of a formal "RP1210 Test Plan", but will be more of 
a "requirements" document (foundation for your own formal test plan).  RP1210 "compliancy" will be self-administered 
by each company.  Lee Lackey of Noregon Systems (llackey@noregon.com) has volunteered to be the task force 
chairman.  This is great news for fleets and independent service shops! 
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3.   Who’s Who in the World of the VDA 
The top three VDA vendors, their “current” flagship adapter, and their legacy adapters are listed below in alphabetical 
order.  Most application developers for OEM/engine/transmission/ABS develop, test, and validate against adapters from 
these manufacturers.   
 
It is also noteworthy to mention that application developers have kept a very close watch on all of these adapters “through 
the years” and have designed and validated their code to work with these adapters.  There are other “non-top-three” 
adapters on the market, some from very recognizable companies, but application developers typically test with the “big 
three” because “they are the ones out there”.  OEMs and component suppliers wanting name branded adapters tend to go 
with these companies as well.  We are not stating that a “non-top-three” adapter will not work, only that it may not be 
extensively tested by the OEM application developers.   
 
Typically, you cannot go wrong with a “late model” (5 years old or less) adapter from any of these companies as each 
product is fairly mature and has been tested very thoroughly with all of the current diagnostic software.  Since these VDA 
vendors each work well with the diagnostic software on the market, they generally compete in the arena of “speed of 
reprogramming”, “means of connecting to the PC”, “ease of install”, “ruggedness”, “number of protocols supported”, 
“customer service”, etc… 
 
Vendor Current “Flagship” Adapter Legacy Adapters 
Dearborn Group (DG) Dearborn Protocol Adapter (DPA) 4+ DG DPA III, III+ 

DG DPA 4 
DG DPA-RF 

NEXIQ Technologies (NT) USB-Link NT Lite-Link 
NT Blue-Link 
NT USB-Link 
NT/MPSI PDM 

Noregon Systems (NS) DLA_USB NS DLA (Parallel / Serial) 
NS DLA_USB 
NS PLC/J1708 Adapter 
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4.   Notes Given to Application Developers 
Although it does not mean much to the fleet or independent service bay, it bears mentioning some of the notes that were 
given in RP1210B to the application developers.  Because of these notes, your future RP1210 experience should be 
simpler and less “eventful”, meaning less tech support “down-time”.  

4.1. “Least Common Denominator” Development   
If the deployment of a software application requires potential compatibility with all VDA’s (total RP1210B-compliancy), 
then the application must be designed based upon the lowest common denominator of adapter performance.   

4.2. Windows Vista and RP1210B-Compliancy 
Microsoft’s deployment of Windows Vista™ has caused a lot of concern in the RP1210 task force.  With Vista, 
Microsoft has basically “virtualized” the “C:\WINDOWS” and “C:\Program Files” directories (possibly other directories 
unknown at the time of this writing).  Microsoft Vista supposedly makes the PC more friendly and secure for multiple 
users on the same PC.  Much task force discussion was around either going to the registry, or to XML files.  It was 
determined that neither would be required if we did the following two things: 

4.2.1. RP1210B-Compliancy for VDA Vendors and Windows Vista 

To be considered RP1210B-compliant: 
 VDA vendors will require that the person who installs the drivers on a Windows Vista machine be logged in 

specifically as "Administrator". 
 VDA vendors will install their drivers for “ALL USERS”, not just the current user. 

4.2.2. RP1210B-Compliancy for Application Developers and Windows Vista 

To be considered RP1210B-compliant: 
 Application developers will also require that the person who installs their application on a Windows Vista 

machine be logged in specifically as "Administrator". 
 Application developers will also require that their applications be installed for “ALL USERS”, not just the 

current user. 
If all VDA and all application developers cooperate, we will reduce the frequency of unnecessary technical support 
calls, as there could be 5-6 (even more) copies of the same driver or application on a single PC.  What is worse is that 
they could be different versions.  An extremely simple example: 

 Technician1 installs VDA Vendor1 drivers at version 1.0, and Technician2 installs VDA Vendor1 drivers at 
version 2.0 (a release that included “major” bug fixes from version 1.0).   

 Technician1 encounters a problem with Application1 (and “buggy” VDA drivers at version 1.0).   He asks 
Technician2 to try the application and it works perfectly (wasting time for the technician and costing the fleet 
money). 

 Technician1 calls the technical support line for Application1, and the people responsible for Application1 
spend hours trying to track down the problem.  This costs both the fleet money, as well as the developers of 
Application1, not to mention VDA Vendor1 if the problem gets escalated to them! 
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5.   The Majority of Problems – C:\WINDOWS\RP121032.INI 
Many of the problems that occur today are a direct result of problems with the file “c:\windows\RP121032.ini”.  But before 
we go into INI problems, it makes sense to give a high level overview as to how RP1210 works. 

5.1. High-Level RP1210 Interface Conceptual 
The following is a diagram of how the RP1210B model is implemented.  It allows VDA vendors to focus primarily on their 
adapters and allows application developers to focus primarily on their application.  This benefits customers of both! 
 

 The RP1210B application developer is interested in only the “RP1210B Application” box. 
 The RP1210B VDA manufacturer is only responsible for the API, the DLL, the VDA Drivers, and the physical 

interface device (VDA). 
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5.2. INI File Background  
RP1210 was developed back in the Windows 3.1 days when INI files were in use by all applications and devices.  
There simply was not a “Windows Registry”.  Most people reading this probably remember editing an INI file in 
Windows 3.1 or Windows 95.  Even though Windows has moved on to a “registry”, and now moving to an XML type of 
hybrid, RP1210 has remained an INI based standard.  If you think it would be fun trying to explain to an end-user how 
to use the Windows “notepad” to edit an INI file, try explaining one how to use the Windows “regedit” tool (a tool that 
could potentially keep the PC from even booting up).  Trust us, INI files are much easier! 
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5.3. The INI File Structure of RP1210 (Main INI File – Vendor INI Files) 
 

Master INI File

Pointers to Vendor INI and DLL Files

Vendor INI File(s)

Also in C:\Windows

Vendor DLL File(s)

Also in C:\Windows

C:\WINDOWS\RP121032.INI

[RP1210_Support]

APIImplementations=AAARP32,BBBRP32

AAARP32.INI

[VendorInformation]

Name=AAA Systems

...

BBBRP32.INI

[VendorInformation]

Name=BBB Company

...

AAARP32.DLL BBBRP32.DLL
 

 
 

5.4. How the RP1210 INI System Works 
There is a “primary” or “master” INI file called C:\WINDOWS\RP121032.INI.  There is only one section 
[RP1210_Support] and only one variable called “APIImplementations”.  This variable points to all installed RP1210 
VDAs on the PC and is only modified when a VDA is installed or uninstalled.  In the above picture, you see that 
vendor AAA and BBB had VDA devices installed on the PC.  These entries point to VDA provided INI files, but these 
INI files are very involved, and tend not to get “mangled”, so we will not cover them.   
  
The “normal” format of the RP121032.INI file is as follows: 
 
[RP1210Support] 
APIImplementations=[vendor1],[vendor2],...,[vendorn] 

 

Each vendori identifies the name of the vendor INI and vendor DLL file associated with the vendors’ VDA API. 
 

A “typical” and “good” RP121032.INI file showing a Dearborn, a NEXIQ, and Noregon API is as follows: 
 
[RP1210Support] 
APIImplementations=DG121032,NXULNK32,PCSRP32 
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5.5. How An RP1210-Compliant Application Uses the INI File Structure  
When an RP1210-compliant application initializes, it completely reads the variable APIImplementations from the 
[RP1210_Support] section of the RP121032.INI file.  It then starts breaking that variable down into single instances of 
installed adapter APIs (“DG121032”, “NXULNK32”, “PCSRP32”, etc).  For each API, it reads that adapters INI file 
(“DG121032.INI”, “NXULNK32.INI”, “PCSRP32.INI”, etc) and builds a list of adapters and protocols supported.  The 
application then presents a list to the user of all of the adapters that it found. 

5.6. Problem - Multiple Commas/Spaces in RP121032.INI 
In 2007, it was noted by VDA vendors that they have been spending a lot of time doing technical support because 
VDA vendors were leaving multiple commas or spaces in the RP121032.INI file during an install or uninstall.  These 
spaces, commas, and commented lines have caused OEM application developer’s issues by not seeing all VDA 
entries in the file.  Thusly, when an end-user installed an adapter (“any adapter”) and was not allowed to select it, that 
adapter manufacturer received a tech support call even though it “was not their problem”. 
 
RP1210B states that VDA vendors shall ensure that when their drivers are installed or uninstalled, that there are no 
stray commas or spaces remaining in the RP121032.INI file.  If spaces are stray commas are seen, the VDA 
install/uninstall application will fix them, not leave them there for someone else’s tech support department to find.  
Also, application developers should ensure that when they parse the RP121032.INI file that they completely parse the 
entire line and not just the first ‘x’ number of entries.  Application developers should be aware that multiple commas 
and potentially spaces could be left in the file.   
 
Although these changes will occur as VDA vendors and application developers roll out RP1210B versions, you as the 
end-user may end up having to deal with INI problems.   

5.6.1. A Bad (But Typical) C:\WINDOWS\RP121032.INI file 

The following shows an INI file in a “mangled” state.  Who knows what happened… 
 

[RP1210Support] 
APIImplementations= ,xxxxxx32, yyyyyy32,, ,zzzzzz32,   ,aaaaaa32 

 

5.6.2. Fix it Using Windows Notepad! 

From the Windows Start Menu choose “Start->Run” and then type “notepad.exe c:\windows\rp121032.ini” in the 
dialog box and click Ok.  Make the INI file look like it should be removing spaces, extra commas and commented 
lines.  The bad INI file should look like the good one (below).  Do a “File ->Save” and exit Notepad.   
 
NOTE:  Only do this if you are very familiar with notepad.  If you were to remove an entry, you would not see that 
entry in your applications.  Also, removing anything in the file up to the “=” could have disastrous results. 
 

[RP1210Support] 
APIImplementations=xxxxxx32,yyyyyy32,zzzzzz32,aaaaaa32  
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5.7. Problem – Applications Not Seeing Installed Adapters 
This one has been causing problems for several years!  Check the above paragraph and ensure that the INI file is the 
way it should be (no extra commas or spaces).  After checking that, there are still some applications that do not 
present the user with a complete list of all installed adapters.  Some applications in the past have only shown the first 
adapter in the list.  Because the problem may still exist with legacy software installed on your PC, we are going to 
show you how to “fix” the C:\WINDOWS\RP121032.INI file so that the adapter you need to use will be seen.  We are 
going to change the INI file so that vendor “aaaaaa” gets to be first in the list.  This still does not fix the problem of an 
OEM application that only “allows” certain adapters to be used. 

5.7.1. Fix it Using Windows Notepad! 

From the Windows Start Menu choose “Start->Run” and then type “notepad.exe c:\windows\rp121032.ini” in the 
dialog box and click Ok.  Make the INI file look below (don’t forget to check for and remove extra spaces, extra 
commas and commented lines).  The initial version of the INI file might look like the one below.  
 

[RP1210Support] 
APIImplementations=xxxxxx32,yyyyyy32,zzzzzz32,aaaaaa32  

 
Make it look like the following: 
 

[RP1210Support] 
APIImplementations=aaaaaa32,xxxxxx32,yyyyyy32,zzzzzz32 

 
  Do a “File->Save” and exit Notepad.  Next, try again to configure the application to see the adapter. 
 
SHOULD THIS NOT GET THE ADAPTER SEEN BY THE APPLICATION, CALL YOUR APPLICATION PROVIDER.  
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6.   Problem/Solution - Number of Client Connections 
In RP1210A, each VDA vendor must support a minimum of 16 clients (connections), but was not clearly defined as to 
how these “clients” were connected.  In RP1210B, we have specified that these clients can be from different 
applications, not just one application using 16 clients.  Some adapters do not support multiple applications. 

6.1. Symptom 
Try to connect to an application and get an error such as:  
 

ERR_CLIENT_ALREADY_CONNECTED  

ERR_CLIENT_AREA_FULL 

ERR_CONNECT_NOT_ALLOWED 

ERR_DEVICE_IN_USE 

ERR_INVALID_DEVICE 

ERR_MULTIPLE_CONNECTIONS_NOT_ALLOWED_NOW     

 

6.2. Potential Solution 
If you are using an adapter that does not support multiple applications, ensure that you have not “minimized” another 
application into “the background”, or commonly referred to as the “Windows task-bar”.  If so, close all open diagnostic 
applications and retry.  Before calling the VDA vendor, try a clean reboot of the system, as the VDA drivers 
sometimes get “hung” (it happens to all VDA drivers from time to time). 
 



TMC S.12 Non-Sanctioned Document Why My Adapter Isn’t Working and What To Do About It 
Revision 1.4 February 7, 2008 
 

This is not a TMC Sanctioned Document and is for Informational Purposes Only. Page   13 

 

7.   VDA Adapters Require Installing Drivers! 
Believe it or not, VDA vendors still get calls from customers who have not even installed the drivers for their VDA.  They 
tell us that they expected that when they plugged it in, that it would work!  Although it seems that even though the PC has 
been in the service bay for years and that “installing drivers” is routine, the reminder still needs to be given.  How are VDA 
vendors calling attention to this? 
 

NEXIQ Technologies PLACES A STICKER OVER THE USB PORT ON THEIR ADAPTERS THAT STATES TO 
INSTALL DRIVERS FIRST.  
 
Noregon Systems HAS A “QuickStart Guide” THAT IS THE FIRST THING SEEN WHEN YOU OPEN THE 
PACKAGE THAT STATES TO INSTALL DRIVERS FIRST. 
 
Dearborn Group WILL BE DOING BOTH STARTING WITH THE DPA5. 

 
Each of the three VDA vendors place the latest VDA drivers on their websites: 
 

http://www.dgtech.com 
http://www.NEXIQ.com 
http://www.Noregon.com 
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8.   You Have to Configure the Application to Use the VDA! 
Believe it or not, VDA vendors still get calls from customers who do not know that they have to configure applications to 
use the adapter they just installed.  Although we understand that some users have been “spoiled” because some 
applications do an “auto-detect”, most applications still require you to configure the adapter.  The following section shows 
how to configure an application to use vendor “VENDOR NAME” and device “DEVICE NAME AND/OR DEVICE 
NUMBER”. 

8.1. Allison DOC 
1. Start program. 
2. Click “Connect to Vehicle”. 
3. Select the Correct Transmission Type. 
4. Uncheck “Smart Connect”. 
5. Click “Connect”. 
6. Click “Advanced Setup”. 
7. Select vendor of “[VENDOR NAME]”. 
8. Select protocol of “J1939” or “J1708”. 
9. Select correct device of “[DEVICE NAME AND/OR DEVICE NUMBER]”. 
10. Click “Ok”. 

8.2. Bendix ABS Diagnostics 
NOTE:  DO NOT RUN Bendix ABS Diagnostics until you have done the following: 
 

1. Start program.   
2. If “Diagnostic Interface Selection” dialog box does not appear, click on “Vehicle Interface Adapter” icon. 

a. Select “RP1210A Device Using J1708 Line: [DEVICE NAME AND/OR DEVICE NUMBER]”  
3. Click Ok. 

 
A screen appears indicating that device selection was a success. 

8.3. Caterpillar Electronic Technician 
1. Start Program. 
2. Click “Utilities  Preferences  Communications” from the menu bar. 
3. Click on “Communication Interface Device” dropdown box. 
4. Select “RP1210 Compliant Device”. 
5. Click “Advanced” 
6. Select “([DEVICE NAME AND/OR DEVICE NUMBER])” in the RP1210 Communication Adapter Device box. 
7. Click Ok 
8. Check "Enable Dual Data Link Service” 
9. Click Ok. 
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8.4. Cummins Insite 
1. Start Program. 
2. Click on “File  Connections  Add New Connection”. 
3. Click “Next”. 
4. Click radio button for “RP1210A” and click “Next”. 
5. Select correct device ([DEVICE NAME AND/OR DEVICE NUMBER]), and protocol you want to use, J1708/J1939. 
6. Click “Next” and a “Connection Name” screen appears. 
7. Click Next and a screen prompts you to indicate whether you want to make this connection active or set up 

another connection. 
8. Click on “make this connection active”. 
9. Click Finish. 

8.5. Detroit Diesel Diagnostic Link V7 
8.5.1. From Windows Start Menu 

1. Start  Programs  Detroit Diesel  Diagnostic Link  SID configure 
2. Select “[DEVICE NAME AND/OR DEVICE NUMBER]”. 
3. Click Ok. 

8.5.2. From Inside DDDL 

1. Tools  Options  Connections Tab  SID Configure. 
2. Select “[DEVICE NAME AND/OR DEVICE NUMBER]”. 
3. Click Ok. 

8.6. Eaton ServiceRanger 3.x 
1. Start Program 
2. Click “Tools  Settings  Connection”. 
3. Under “Driver” choose “[VENDOR NAME]”  
4. Select “[DEVICE NAME AND/OR DEVICE NUMBER]” for both the J1708 and J1939 device. 
5. Click Ok. 

8.7. Freightliner ServiceLink 
1. Start program. 
2. From the top menu bar, choose “Admin”. 
3. From the left menu bar, choose “Vehicle”. 
4. Click on “Show All Devices”. 
5. In the “Vendor” box, choose “[VENDOR NAME]”. 
6. Select “[DEVICE NAME AND/OR DEVICE NUMBER]” in the J1708, J1939, and CAN dropdowns. 
7. Click “Save Settings”. 
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8.8. International Truck and Engine 
8.8.1. MD 

File   MD Settings   COM Device   Window with general VDA selection 
“[VENDOR NAME]”  Window with specific port “[DEVICE NAME AND/OR DEVICE NUMBER]”  

8.8.2. Navistar Hyd ABS 

File  Hydraulic ABS Settings  COM Device  Window with general VDA selection  
“[VENDOR NAME]”  Window with specific port “[DEVICE NAME AND/OR DEVICE NUMBER]” 

8.8.3. Navistar IPC 

File  Settings  COM Device  Window with general VDA selection 
“[VENDOR NAME]”  Window with specific port “[DEVICE NAME AND/OR DEVICE NUMBER]” 

8.8.4. Diamond Logic Builder (DLB) 

Tools Select Com Link  Listing of adapters “[VENDOR NAME]”   Listing of ports“[DEVICE NAME AND/OR 
DEVICE NUMBER]” 

8.8.5. Service Assistant (The New MD - Should Be in Marketplace Shortly) 

Press third button from the top along the left side (has an icon that 
looks like a miniature interface cable.)   A window comes up that says 
Communication Device Selection and has two drop down boxes.  Box 1 is 
device selection “[VENDOR NAME]” Box 2 is Device ID “[DEVICE NAME AND/OR DEVICE NUMBER]” 

 

8.9. Meritor-WABCO ABS Toolbox 
1. Start Program. 
2. Click “System Setup”; then select “COM Port”. 
3. Select “[VENDOR NAME]”, the protocol to use J1939 or J1708. 
4. Select [DEVICE NAME AND/OR DEVICE NUMBER] and click Ok. 
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8.10. Volvo/Mack VCADS Pro 
8.10.1. From Initial VCADS Setup  

1. When prompted to configure a “Communication Unit”, instead of the “9998555” or “88890020” entries, select 
“RP1210A adapter”. 

2. When prompted for the adapter, select “[DEVICE NAME AND/OR DEVICE NUMBER]”. 
3. Select “USB” for the Port. 
4. Select “J1708 for the protocol”. 
5. When prompted for the “Electrical Systems”. 

a. Click “Volvo Trucks – VERSION2” and select “RP1210A Adapter” 
b. Click “Volvo Trucks – Vehicle electronics ‘98” and select “RP1210A Adapter” 
c. Click “Mack Trucks – V-MAC I/II/III, ITC” and select “RP1210A Adapter” 
d. Click “Volvo Trucks – V-MAC IV” and select “RP1210A Adapter” 

6. Continue with installation. 

8.10.2. From Inside VCADS 

7. Start Program. 
8. Click the “Tools” menu and choose “Options”. 
9. Select the “Comm. Unit Configuration” tab. 
10. Select “RP1210A Adapter” and then select “[DEVICE NAME AND/OR DEVICE NUMBER]”. 
11. Select “USB” for the Port. 
12. Select “J1708 for the protocol”. 
13. Go to the “Comm. Unit Selection” tab. 

a. Click “Volvo Trucks – VERSION2” and select “RP1210A Adapter” 
b. Click “Volvo Trucks – Vehicle electronics ‘98” and select “RP1210A Adapter” 
c. Click “Mack Trucks – V-MAC I/II/III, ITC” and select “RP1210A Adapter” 
d. Click “Volvo Trucks – V-MAC IV” and select “RP1210A Adapter” 

14. Click “Ok”. 

8.11. Volvo/Mack Premium Tech Tool (PTT) 
Select Settings from the PTT menu. 
 
Communication Unit configuration tab:  It is here that you select the settings for each adapter that you may use.    
For example, if you have an RP1210A adapter, it is here that you select which adapter, port, and protocol.   
 
NOTE:  This identifies the settings for each adapter.  It does not select which adapter the PTT application will use to 
communicate with the vehicle. 
 
Comm unit selection tab:  It is here that you identify which adapter is to be used by the PTT application to 
communicate with the vehicle.  You may have to change this selection depending upon the vehicle.  For example, if 
you typically use an 88890020 adapter in direct mode, when you need to communicate with an older vehicle you will 
need to change to RP1210A adapter or the 9998555 adapter, depending upon the vehicle. 
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9.   Connect and Un-Connecting on the DB Side of Cable 
There can be electrical problems when you connect and disconnect the D-Shell DB-15 or DB-25 cable from the adapter 
WHILE THE CABLE IS STILL CONNECTED TO THE TRUCK AND THE TRUCK IS HOT (ON).  Be aware that the power 
and ground connectors are sometimes close together and the VDA vendors have seen “sparks fly”. 
 
The recommendation is to always use the Deutsch connector to connect/disconnect from the vehicle. 
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10.   Two USB Port Issues – Not VDA Issues 

10.1. VDA Drivers are NOT Microsoft Certified 
If you plug in a VDA (or any other USB device) that does not have "Microsoft Certification" associated with it (none of 
the three VDA vendors do) into a different USB port than where it was installed the first time, you are going to get the 
"New Hardware Found" wizard again.  No need to contact technical support, choose “Install the software 
automatically (Recommended)” and press the “Next” button and follow instructions.  For the small quantities in the 
heavy-duty adapter marketplace, it is cost-prohibitive for a VDA vendor to pay the exorbitant amount of money that 
Microsoft wants to get them “certified”.  Hitting cancel when seeing this is a sure-fire way for your adapter “not to 
work”. 

 

 
 

10.2. Inherent USB Port Problems on PCs 
Another common USB trait sometimes causes a VDA to lose communications with the PC.  If you lose PC 
communications, before calling the VDA vendor: 
 
1. Unplug the USB cable from the VDA. 
2. Unplug the vehicle-side cable from the truck (ensure power is off for 3-5 seconds). 
3. Plug the USB cable into the VDA. 
4. Reconnect the VDA to the truck. 
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11.   Before You Call Your OEM Application Help Desk 
Before calling your OEM Application help desk, you should validate that the adapter you are using can be “connected to” 
(seen by the PC) and “can see message traffic” (meaning an application should be able to do the same).  To do this, you 
would use an adapter validation application, which are commonly available for free from your VDA vendor.  We will cover 
two of them, one from Dearborn Group, and one from NEXIQ.  Noregon Systems has several applications that they use 
depending on which issue you have and they will e-mail it to you when needed. 

11.1. Dearborn Adapter Validation Tool (Commonly Called “RapidCheck”) 
AVT is a completely RP1210-compliant application that will work with ANY RP1210-compliant device and ANY RP1210-
defined protocol.  This makes it easy for the end-user with any adapter to ensure that the PC can read data.  The main 
screen, showing a successful connect and a successful reading of data is below.  Start by selecting the vendor, device 
and protocol you would like to try, and then click “Run Test”.   
 

11.1.1. Good Connect, Good Reading of Data 
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11.1.2. Good Connect, No Reading of Data  

The following screen shows that the AVT was able to connect (“see”) the adapter, but did not see traffic on the 
data bus. 
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11.1.3. Bad Connect, No Reading of Data  

The following screen shows that the AVT was not able to connect (“see”) the adapter.  Application cannot try to 
read data. 
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11.1.4. Results Discussion Screen 

Once the test is complete, the application will display an informational screen listing some steps to correct the 
issues based upon what it was able to determine.  There are three possibilities (as shown above): 

1. Good Connect to Adapter (PC can “see” VDA) 
i. Good Data Read (PC can also “see” vehicle Messages). 

2. Good Connect to Adapter (PC can “see” VDA)  
i. No Data Read (PC can’t “see” vehicle Messages). 

3. Failure to Connect to Adapter (PC cannot even “see” the VDA). 
 

.  The following is a “results discussion screen” for when the AVT can both connect and read data.    
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11.1.5. Automatically Fixing a “Mangled” INI File – Moving the Current Adapter to Front of List 

The application also has a button “Fix INI File, Make This Vendor First in List” that will allow you to view the 
C:\Windows\RP121032.INI file and fix it if there are errors detected.  It also puts the current VDA vendor in the 
front of the list.  Below is the screen showing a bad INI file and what it will look like after pressing the “Make 
Changes” button.  
 

 
 



TMC S.12 Non-Sanctioned Document Why My Adapter Isn’t Working and What To Do About It 
Revision 1.4 February 7, 2008 
 

This is not a TMC Sanctioned Document and is for Informational Purposes Only. Page   25 

 

11.2. NEXIQ Device Tester 
The NEXIQ Device Tester application works with any NEXIQ adapter and is very simple to use.  Simply select the 
NEXIQ device and protocol and click “Start Test”.  If the application is able to see data on the link, it will show up in 
the application.  Below is an example of a successful reading of data. 
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12.   When You Call Your OEM Application Help Desk 
If you can see traffic on the data bus, then you should call your OEM application help desk.  If not, call your VDA vendor 
help desk.  The three VDA vendors mentioned herein have been hearing disturbing news from our end-users.  They tell 
us that when they call the OEM application help desk, they receive the following comment, “You need to buy ‘our’ 
adapter”.  Ask them if their application is RP1210-compliant.  If so, tell them that you know that the VDA vendors listed 
herein are RP1210-compliant and are most likely tested with their application.  Also tell them that you have run the VDA 
vendors’ validation tool and can see data on the vehicle network. 
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13.   Troubleshooting Flow Chart 
The following list the first steps a user should take prior to calling their “DIAGNOSTIC APPLICATION PROVIDER” to find 
out why the application is not working.  In the event that the end-user has not gone through these steps, the diagnostic 
application provider should run the user through them. 
 

13.1. Connection Issues 
1. Is the power light to the adapter on? 
2. If using a plug and play interface such as USB or BlueTooth.  Turn up the speaker volume; unplug the adapter 

and then plug it back in.  You should get the “ta-dahhh” sound when the operating system and drivers connect to 
the adapter. 

 

13.2. INI File Problems 
1. Per this document, check to ensure your C:\WINDOWS\RP121032.INI file is in the proper format and is not 

“mangled”.  If so, fix it. 
2. Look at the INI file to see if an entry for your adapter is there.  Although it is an ugly solution, try moving it to the 

front of the list.  If the entry is not there, download and install the latest VDA drivers. 
 

13.3. Data Flowing? 
1. Use the VDA vendors’ validation application to check to see if it can see data on the data bus. 

 

13.4. Configured Properly? 
If there is data flowing through the adapter, then there is no need to contact your VDA vendor’s technical support 
department.  Before calling your application provider, try the following: 
 
1. Using the information found in this document, ensure that the application is “completely” set up to use the adapter 

that you want to use.  Note that for some applications (like Volvo/Mack VCADS above), you have to select your 
adapter in several different locations. 

 


